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Module 5 : Shortcut Keys and How to
Navigate the Sage 50 Accounts Desktop

e What are shortcut keys and how to use them in Sage 50;

e A description of the important features of Sage 50 desktop and how to use them;
e How to find and drill down on transactions and print reports;

e Toolbars in the Report Preview and Report Selection window;

Objectives

e What are shortcut keys and how to use them in Sage 50;

¢ A description of the important features of Sage 50 desktop and how to use them;
e How to find and drill down on transactions and print reports;

e Toolbars in the Report Preview and Report Selection window;

e Features of the Report Designer tool and how to add groups to reports;

e Features of the Sage 50 dashboard;

e How to select and deselect single and multiple records.

5.1 Introduction



Shortcut
keys

Shortcut keys help users access faster frequently used functions.
This module will explain the different shortcut keys available in Sage 50.

This module will explain how to navigate the Sage 50 desktop and the different features available.
These features include dashboards and process maps amongst others.

The user can define the most suitable view which will determine how the Sage 50 desktop screen
will appear. Defining the view can help customise the display that suits the user's unique

requirements.

The welcome page offers several options for beginners. You can choose between reading PDF files
that explain the features of Sage 50 or go to the Practice section directly.

Users can create, modify and print single or multiple records. This can be done by selecting the
records before processing.

5.2 Shortcut Keys Available in Sage 50

Sage 50 features can be accessed with the help of the keyboard and
the mouse.

The mouse is the ideal choice for pointing and clicking on menus and navigation aids amongst other
operations.

The following list of Sage 50 shortcut keys can be used in addition to standard windows shortcut
keys. Examples of standard windows shortcut keys include CTRL + C (copy) and CTRL+ V (paste).
The following list includes Sage 50 shortcuts that include the CTRL key plus a letter of the
alphabet:

e CTRL + X = Cut



e CTRL + C = Copy

e CTRL + V = Paste

e CTRL + D = Find next

e CTRL + E = Delete record

e CTRL + F = Find

e CTRL + N = New company

e CTRL + O = Open company

e CTRL + B = Backup company
e CTRL + R = Restore company

e CTRL + P = Print (invoices, reports, payments, quotes, etc.)

Additional Shortcut Function Keys available in Sage 50

F1 = Displays the relevant help for the current window

Shift + F1 = Helps reposition the cursor to ‘What's this help' section

F3 = Finds transactions

F5 = Saves records and posts transactions in specific windows

F7 = Conducts a spelling check

F10 = Helps switch between an open window and the menu bar

CTRL + F4 = Closes the current document window

e ALT + F4 = Closes the current application window

e CTRL+ F6 = Moves the cursor to the next window

e SHIFT + CTRL + F6 = moves the cursor to the previous window
e UP and DOWN arrow keys = Navigate lists of records

e ENTER = Helps complete the fields with the currently selected record or helps expand the
stock item inventory record folder



e RIGHT and LEFT arrow keys = Help expand and collapse sub-lists that are marked with a '+
symbol.

In each window of Sage 50, there are certain underlined keys in the field name. The user should
press the ALT key plus the underlined letter, in order to access the specific field.

For example, in the General Journal window, the date field has the 'D' underlined. This means that
the user should press ALT + D in order to instantly access the date field.

Users who wish to use the keyboard to navigate the screen can consider using the ENTER or TAB
keys, to switch between different fields.

If you wish to access a previous field, press SHIFT + TAB or SHIFT + ENTER.

How to Access Help

There are four ways that users can access Help in Sage 50:
1. Clicking on the Help button: This contains help information related to the current window.

2. Pressing the F1 key: This is a shortcut key, as described above, that displays information
related to the current window.

3. Browsing the Help menu: The Help menu comprises all the help available in the programme,
organised into a contents and index format.

4. Tooltips: When the user positions the cursor over a button, a small box will appear which
contains information regarding the function of the button.

5.3 How to find Transactions

Find
transactions

The 'Find transactions' menu can be accessed, either with the help



of shortcut keys located on the left-hand side of the screen or from the 'Edit' menu.

In order to perform a search, fill in the filter criteria according to date range, etc., and then press
the 'Find' button located in the centre of the 'Find transactions' window.

The results are displayed at the bottom of the screen. If you wish to view further details, double-click
on the transaction. Similarly, if you wish to change the filter criteria, click the heading of a different
field.

The 'Find transactions' search can be printed using the 'Print' button on the toolbar.
The different transactions that appear in the 'Find transactions' search can be any one of
the following:

General Journal

e Inventory Adjustment
e Purchase

e Purchase Order

e Payroll Entry

¢ Quote

e Sales Invoice

e Sales Order Time Ticket
e Assembly

e Payment

¢ Credit Memo

* Receipt

e Expense Ticket

e Vendor Credit Memo

o Work Ticket
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5.4 How to Preview Reports

Preview
reports

Users are able to generate reports from various navigation centres
of Sage 50.

‘Select report or form' automatically categorises reports into different groups according to their
function. For example, these groups could include examples such as 'Accounts receivable' for
customers and sales. You will be able to have a short description for each report.

In addition, you can change the appearance of a report or the information that is presented, by
double-clicking on the name of the report.

How to Customise a Report and Groups within the Window

The user can use the toolbar to customise the report or groups within the window. Here are the
different options available:

Close:

This will close the current window

Delete:

This will delete all the customised reports, forms and report groups, with the exception of the
standard reports provided by Sage 50.

Group:



A report group consists of one or more reports related to one or more aspects of the company. When
the report group is printed, all the reports in the group are printed. Groups are explained in greater
detail in the next section.

Print:

The Modify option will take the user to the different print options. You can specify the number of
copies, the range of pages to be printed, etc. Click OK to commence printing.

Display:

This option helps preview the report on the screen.

There are some additional options available. However, please remember that the following options
are not available for financial statements:

Options:

Clicking on Options will open the filtering window, which allows the user to pre-set information to be
viewed in the report. You can specify the information that you want to see on each report.

Columns:

Opening the Columns window for a specific report allows the user to modify the columns that appear
on that report.

Fonts:

Clicking on the Fonts window allows the user to select the appropriate fonts for different sections of
the report.

Send to:

The 'Send to' window will provide a drop-down list that consists of the following options:

Email:

The user can email the report in PDF format (Portable Document Format).

Excel:

If you select the Excel option, Sage 50 will open Excel and insert the report into a worksheet. Most
of the original formatting is retained.

PDF:

The user can save the report in PDF format, which can be opened with the help of Adobe Acrobat
Reader.



In the PDF option, you also have the following choices:

e Styles: Clicking on this option opens the Report Styles window, where you can group different
font styles for use in reports.

e Copy: The Copy option allows users to open the Copy reports and Financial window, which
enables the copying of financial statements and reports from one company to another.

Once the report has been run, it can be viewed by clicking on the Display option. The report will
appear in the Report preview section, where the contents and appearance can be customised.

Drilling Down on a Report

The user can drill down on a transaction, to view the original entry window. Move the cursor over
the transaction, and a small magnifying glass will appear.

Double-click and the original transaction window will appear. You can then view the transaction,
modify details, if allowed, and save the transaction.

Once the user closes the transaction window and reopens the report, it will be updated with the
changes.

Features of Toolbars in the Report Preview and Report Selection Window

Save:

Users can save a report under the desired name, and the report appears in the Report or Form
window, under a slightly different icon.

Setup:

Clicking the Setup option will open the Page setup window. From here, the user can customise print
settings, such as page source, page size and print orientation.

Hide/Show:
This option either removes or adds the report header, which comprises information, including
company name, report title, date, range and other filter criteria.

Find:

Selecting the 'Find' option on the Report window helps search for text or numbers in the report.



How to Preview Reports - 1m 40s

5.5 Features of the Report Designer Tool

Report
designer

Sage 50 offers user-friendly functions, such as Report designer.

This feature allows users to quickly and conveniently access updated company data. Users can
maximise efficiency by generating from Sage 50 different reports, such as invoices, statements,
letters and orders.

Users can incorporate their personal preferences, for example, the addition of the company logo or
the addition of new information with regards to accounts.

Each module in Sage 50 has its own dedicated Reports section, from where the user can print the

report. Select the relevant module, for example, Customers, then click on 'Reports', 'Preview’, then
'Print' against the relevant document name.

Quick Print Option

In later versions of Sage 50 (2012 and later), users can print quotations, invoices, etc. with one click,
as opposed to being obliged to set such options as printer and document each time.
The Quick Print option is available in the following modules of Sage 50:

e Invoices and Credits

¢ Quotations

¢ Sales Orders



e Purchase Orders

For example, click 'Menu', 'Quotations', 'Default' then 'Quick print tab'.
Step 1

Click to the right of the document that you wish to print, in order to browse layouts.

Step 2

Choose the default layout for the documents that you wish to customise for the Quick print option.
Please keep in mind that you cannot change the layout for the document by deleting the option. If
you wish to select a different layout, you will need to repeat steps 1 and 2.

Step 3

The Quick print option will use the default printer specified in the Quick print settings. If you wish to
change the printer, you can use normal print options instead.

Tip: Users can print multiple invoices or purchase orders using the Quick print pre-defined option.
However, you cannot mix for printing reports from different modules, such as purchase orders and
sales orders.

5.6 How to Create Groups for Reports in Sage 50 Accounts

Create
groups

This feature allows users to sort data in reports into more
manageable groups. (Please note, this feature isn't available in all versions).

Users can use the Group function, to create totals, summarise data and separate the data into
different groups.

Report groups can contain reports from different areas and can also include any customised groups.
All reports can be accessed on the Reports index. If you wish to view reports from a particular area,
you can click on the drop-down list of reports for the specific module. As you keep adding reports to
a group, they get added to a box on the right-hand side of the screen.



Once you have completed adding all the reports in the group, the group can be saved for later use.
Additional features of report groups include:

Report index:

The user can select a specific area from the Report index, to choose reports related to that area. The
default option is Index to all reports, whereby all reports are listed.

Add a report to the group: Highlight the name of the report in question, and select the button, in
order to add the report to the specific report group.

Remove:

The user should highlight the specific report in the group, and then select the button, in order to
remove the report from the group. The report will still exist in the default report index but will no
longer be included in the report group.

Once the user has saved a group, the group will appear in the Select a form or Report window. If you
wish to preview the reports in a group, click on the group name in the module. If you wish to
preview a specific report, then double-click on the report name in the group.

In order to print all the reports in a report group, highlight the group and then click the print icon in
the toolbar. The reports will get printed in accordance with the date criteria specified in the filter.

5.7 How to Navigate the Sage 50 Desktop
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This means that you can minimise, maximise, as well as resize the Sage 50 desktop window whilst
running other Windows applications in the background.

Sage 50 is compatible with most Windows products and versions.

Open the Sage 50 desktop by double-clicking on the icon. The Sage 50 window will open on the
screen. The appearance of the desktop view will depend on how you have configured the view
option.

The view option includes the following features:

e The modules that will be displayed when you open Sage 50.



e The module type that will appear when each of the windows is opened. The module types could
include dashboard, ledger lists or process maps. Process maps are workflows related to a
specific module, and they can be used to switch between modules quickly and conveniently.

e Whether the user wants to switch off the dashboard and process maps globally.

At any point, the user can press the F1 key.

FACT
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There were 5.4 million businesses in the UK in 2015. Out of these, 99% consisted of small or
medium-sized businesses that employed between 0 and 249 workers.

Source: parliament.uk

5.8 Dashboards



Dashboards are a quick and convenient way of obtaining an
overview of a module at a glance.

Dashboards are available for all modules and, every time you open the dashboard, the information
that you see is the updated version. In addition, you can click on the 'Update’ option, in order to
refresh the information on the dashboard.
Dashboard views can be customised by using view options, in order to keep an overall track of how
the business is progressing.
For example, the user can view at a glance the items that are running low on the inventory or the
top customers.
To define view options:

1. Go to the Sage 50 menu bar and click on '"Tools' then 'Options'.

2. Click on the View tab.

3. Select the options that are required.

These options include the following:

e Initial view: From the drop-down list, select the module that you want displayed every time you
open Sage 50. Please note that selecting the initial view is not available if the user is in the
practice mode.

e Default view: For each module, the user can define the preferred screen types from the drop-
down list. This is the screen that will appear every time that specific module is opened.

e Turn off dashboards: This option will turn off all dashboards, and the user can no longer use
the default view option. If the user has already selected a default screen, the selection is
appropriately modified.

e Turn off all process maps: Selecting this option will turn off all process maps. Similar to
turning off dashboards, all default selections will be changed to the appropriate list option.

e Don't display the welcome page: Users who do not wish to display the welcome screen should
click on this option.



If you wish to save the new settings, click 'OK'. If you do not wish to change from your previous
settings, click on 'Cancel'.

5.9 The Different Window Types in Sage 50 Accounts

Whenever the user selects a task or link from the Sage 50
navigation Bar or tool bar, a new window appears in the work area.

The user has the option of opening and working in several windows simultaneously, as opposed to
having to close one window and open another.

Whenever a new window is opened, a tab appears on the bottom left-hand side of the screen. In
order to switch between windows, click on the tab at the bottom.

For example, you may need to switch between the welcome, suppliers, customers and ledger
windows.

Process Maps

Process maps are diagrammatic representations of the workflows associated with each module. Each
workflow consists of blocks which represent functions available in Sage 50.

Process maps are available in two modules: Customers and Suppliers.

Navigating the Welcome Page

When the welcome page opens, users gain access to centralised resource links and files. The three
main options on the welcome page include:

1. What should I do first? This section is ideal for beginners who need to have some idea of where
to start. It provides a screen on which to get started, by providing a list of introductory tasks.
This section also contains tutorial simulations of tasks which can be accessed by selecting the
Tutorials option from the Help menu.

2. What's new? This section lists and explains new features of that particular version of Sage 50.



3. Just practice: This section will take the user directly into a practice session.

Additional Information

1. Regular tasks: This section helps refresh the user's memory regarding tasks that they may not
have performed for a long time. When you click the Regular tasks window, you are taken to a
second screen. Here, you can review complex tasks, by viewing tutorial simulations that can
be accessed from the Help menu.

2. PDF Guides: PDF guides contain specialised and industry-specific information regarding tasks

that you can perform in Sage 50. By reviewing the PDF guides, you can maximise your use of
the software.

Users who are unable to open the PDF guides can do one of the following:

1. Open Adobe Reader and click on the PDF document link

2. Consider configuring the browser to display PDF files, as explained in Adobe Support.

Contact Sage

This section of the welcome page provides web links and contact information for users who wish to
get in touch with Sage. It has numerous links to websites that contain useful information, including
information regarding HMRC rules and regulations.

5.10 How to get started with Sage 50 Accounts



List Windows

Users will find themselves working on several functions. You can set the work area to display the
record(s) that you are working on. Users may need to create records, or they may work on records
that have already been created.

As the user creates new records, they are stored in the list according to reference number or code so
that they are easy to access. New records are automatically added to the list, and commands allow
the user to tweak the records.

If there are more records than a page is able to display, you will see a scroll bar.

How to Select a Record for Processing

Select the record with which you wish to work, then choose the command from the toolbar. In order
to select a record, put the cursor on it and left-click it to highlight it. The record is now selected.

How to Select Multiple Records

Users may have to select multiple records for processing or print a selection of records. Follow the
same method of selection as for a single record, i.e. left-click the records, and all of them will be
highlighted. Alternatively, you can move the cursor over multiple records and hold the Shift or Ctrl
key, in order to highlight a set of records for processing or printing.

After you click on multiple records, the first record appears in the window and is ready for
processing. As soon as you finish processing the first record, the second one will appear in the
window. If you wish to go back to a previous record, press 'Previous'.

If the 'Activate smart totals' option has been activated in the Company preferences section, Sage 50
will display the total of records highlighted at the bottom of the list.

You can also view the total balance, by adding all the balances in each record in the Total amount
box. There are different ways in which the total amount will appear. For example, the total could be
displayed as one balance in the invoice window, or it could be displayed as a debit or credit balance.
Tip: The Total amount box will only display the debit or credit balance, if the Nominal ledger option
has been included in the list layout.

How to Deselect a Record

Move the cursor over a highlighted record and press the space bar to deselect it. Once you deselect
the records, the total number of records at the bottom of the list will automatically decrease.



Similarly, the total amount will automatically be adjusted.

Assignment

Shortcut Keys and How to Navigate the Sage 50 Accounts Desktop
Time: 20+ minutes

Now it is time to put what you have learnt in Module 5 to the test. Work your way through this
worksheet and do your best to fully participate in every activity set.

Download the worksheet below and complete.
Download Worksheet (PDF)

Module Summary

Sage 50 Accounts has been designed to allow users to be able to maximise efficiency and
incorporate personal requirements because each business is unique. The Report designer helps
customise reports and financial statements and helps implement aesthetic as well as contextual
changes.

The underlying objective of Sage 50 Accounts is that, the less time a business owner spends on their
accounts, the more time they will have to spend on other aspects of the business. This is why the
functions are easy to use.

Beginners can choose the most suitable option from the Welcome page. They can get introduced to
various tasks and functions, by viewing the tutorial simulations in the Help menu, and they can
access websites and links that provide useful information regarding Sage 50, as well as such
information as HMRC rules and regulations.

Sage 50 provides users with stationery requirements, such as labels, envelopes, invoices and
payslips. The stationery is designed to correspond with Sage 50.

Accurate and updated reports can help with the day-to-day running of the business, as well as help
the user make important decisions regarding the business.

The developers of Sage 50 understand that each business is different and have designed Sage 50
and its various versions to accommodate the evolving requirements of small businesses.


https://newskillsacademy.co.uk/wp-content/uploads/2016/11/Sage-50-Beginners-Worksheet-Module-5-1.pdf

[Tweet "I just completed Module 5 of the Sage 50 Fundamentals of Accounting and financial
management Course"]



